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motivation

Polarized neutrons allow the discrimination of spin-flip (sf ) and non-spin-slip (nsf ) contributions to neutron scat-
tering cross-sections. In the standard polarized-beam setup, a magnetic guide-field provides the eigenstate quan-
tization axis for the neutron spin along the entire neutron beam path. This means the neutron-polarization is
produced and then possibly flipped or filtered into one of two possible spin-eigenstates, either with the expectation
value 〈sz〉 in the direction of the guide-field (u) or anti-aligned with that direction (d). The sample cross-section
can only scatter the polarized neutron into one of these two eigenstates because the guide-field is present at the
sample positions as well. Finally the spin detector(filter) will only measure polarized neutrons with one of these
two eigenvalues. There are then only four possible spin-dependent cross-sections, Sn, that exist with this standard
polarized-beam setup, with each cross-section labelled by the neutron-polarization eigenstate before and after the
scattering event as, n = uu, dd, du, ud. These four labels are also used to specify the spin-flipper-states (filter-states)
of the polarized-beam instrument that nominally select each cross-section, with the first letter of the label describ-
ing the flipper-state of the spin-flipper in the incident beam and the second letter describing the flipper-state of the
spin-flipper in the scattered beam. Each of the spin-flipper-states corresponds to a measured neutron count-rate
in the instrument detector, with the same labels. Due to the nature of the neutron magnetic-dipole interaction,
the spin-dependent cross-sections also depend on the neutron spin direction (provided by the orientation of the
magnetic-guide-field at the sample) relative to the direction of the Q vector, or wave-vector momentum transfer.
The standard modes that are usually measured are with the magnetic-guide-field at the sample along the direction
of Q or with the magnetic-guide-field perpendicular to Q.

The quantitative measurement of the polarized-beam cross-sections depends on the efficiency of producing
polarized-neutrons with the selected pre-scattering spin-eigenvalue, and the efficiency of detecting the final scattered-
neutrons with the selected spin-eigenvalue. These efficiencies are NOT unity, so that some neutrons will be de-
tected in flipper-state channels that do NOT correspond to the scattering process selected by spin-flippers. For
example, neutrons will leak into the sf channel even when the scattering cross-section is pure nuclear with no sf
component, because the incident beam already has some neutrons in the sf channel. The NON unity efficiencies
can be measured, and this supplies a method for correcting for the flipper-channel leakage. pbcor is computer
software that makes this correction for NON unity polarizing and spin-detecting efficiencies, and also makes the
correction for possible NON unity efficiency of the adiabatic transport of the polarized neutrons and possible NON
unity efficiency of the spin-flippers (or filters) that select the eigenstate of the incident and scattered spin-states.
This correction is applied to each polarized-beam data point.

A polarized-beam data point is a set of measured count-rates all taken at the “same” values of experimental
parameters (Q, E, EI , EF , temperature,magnetic− field, guide− field−mode, etc. ), except that the spin-flipper states
can vary. The following will show how to calculate the spin-dependent cross-sections from the measured count-
rates of a polarized-beam data point.

The model for the measured count-rate, Cm
0 , (the subscript 0, indicates that this is a modeled value) in a

polarized-beam data point when the instrument flippers are set to the state m, as a function of unknown polarized-
beam scattering cross-section count-rates, Sn, (where the cross-section index n ranges in the set uu, dd, du, ud) is
given by the linear equation

Cm
0 (t) =

∑
n

Tmn(t) Sn.

The transmission coefficients, Tmn, and measured count-rates, are functions of time, only when the polarized-
beam instrument is using He-3 spin-filter devices. Without time dependence, or if only a single measurement is
made in a given channel, then the model count-rates can be replaced with the average of measurements in each
channel, Cm

0 (t) = 〈Cm〉 (t). Then the transmission matrix can be inverted to obtain the solution for cross-section
count-rates.
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Sn = {Tmn(t)}−1 〈Cm〉 (t) .

In the time-dependent case when measurements are repeated for the count-rates in a channel, there is no
simple way to do averaging to obtain an effective count-rate for that channel. In this case, index the counting
times to produce the model

Cm
0,i (ti) =

∑
n

Tmn
i (ti) S

n.

Now it is required to use linear least-squares to solve for the Snin terms of the measured count-rates, Cm
i (t),

χ2 =
∑
i

wi (t)
(
Cm

i (t)− Cm
0,i ((t))

)2
,

which means minimizing χ2.
To see the details of this analysis including the error propagation, go to the HELP menu and select “calculation

details” or look in the document PBcorrect3.pdf.

software installation

The software can be downloaded from http://ncnr.nist.gov/equipment/he3nsf/data_redux.html http://ncnr.nist.gov/equipment/he3nsf/data_redux.html
. 64 bit versions are available for Linux , Windows and Darwin(MAC) platforms. The software is in a ZIP file, which
contains a standalone executable, pbcor64 (add .exe for Windows) and help files as PDFs.

The Windows distribution also includes the Visual-C run time library msvcr120.dll appropriate for the version 3
build. Most Windows7 computers will not have this library unless VC is installed. With admin priveleges copy this
dll into the Windows/System32 folder. This should allow pbcor64.exe to run. If there is still a problem running
the executable, download the VC redistribution package from https://www.microsoft.com/en-us/download/
details.aspx?id=40784 https://www.microsoft.com/en-us/download/details.aspx?id=40784

The Linux and Darwin distributions include two folders that contain binary packages that get loaded by pbcor64,
and are required for pbcor64 to start. If you start pbcor, and it gives an error dialog saying it can’t load libraries
Tclpbs or Bltxs, then you will need to put the included package folders into the /usr/local/lib directory. If for
some reason you cannot do this, but can put the folders in some other directory which supports executable
shared libraries (has exec privilege) then you need to identify this folder by settinng the environment variable,
pbcorDir=YourLibraryFolderPath.

software overview

The software capabilities in the order they are normally performed:

• go to or select data directory which also contains the He3-cellFile.

• read ICE or ICP data files.

• select Y data columns to analyze as polarized beam data

• subtract a constant fast background.

• make groups of files which contain data for polarized-beam data points.

• select the experiment configuration-file (He3-cellFile), monochromator/filter and beam-monitor options, tol-
erances, and cross-section constraints.

• solve all of the polarized-beam data points in a group.

• plot the group solution.

• view the solution text files.

• subtract or average group solutions (e.g. horizontal-fld - vertical-fld) and plot/view the results.

• save group plots to graphics file.

• save session.
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software utilities

The software provides the following utilities:

• He3-cellFile editor for modifying or preparing configuration files.

• polarized-beam correction simulator, to estimate intensities and errors, and see how the correction works.

• file viewer, views source, solution or any other text files.

• file plotter, quick 2-D plots of any ICE or ICP file.

software details

data selector and group-options

Reading data and setting analysis options are handled on the left side of the main application window, with a
file-selector listbox data selector, and an analysis options section titled group options.

data selector

UNIX users should start the program in the directory where their data files reside. WINDOWS users will get to
choose this directory when the program starts. The working data directory is listed in the window-manager bar at
the top of the main application window.

Populate the datafile listbox by entering a glob-pattern (selects all readable non-executable files) and then press-
ing the FILTER button. Be aware that copying files from UNIX to a MSwindows filesystem may mark the files as
executable. Select files for reading by click-dragging for a range, or CTRL-click to add or remove individual files to
the selection. When the selection is prepared, use the READ sel button to read the files so they show up in the
current group in the group selector which is the right-side of the gui. The filenames in the data selector listbox get
modified when they are read into the group selector, by adding extensions .x or .x.# because extra data columns
are added. If background is subtracted, an additional .s extension is added. The software avoids over-writing
existing files. This is the reason for the sequence numbers added in the extension, in case a file is read multiple
times. The user can avoid this propagation of files by deleting .x* files when starting a new analysis session,
but only if these files are not to be used again by a saved session. The first time files are read the experiment
instrument is determined, and then some defualts get set in the group options section shown below. For MACS
these include setting the mono/filter to “Be filter” (which had no higher order wavelength contaimination), and the
monitor position to “before He3 pol”
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group options

cellFile

The configuration cellFiles found in the data-directory are listed in the top menu-button in the group options
section. to be used for the current group The analysis relies on this configuration file for the polarized beam setup,
which will contain information about He-3 spin-filters, beam transport efficiency, etc. This file is made available by
the He-3 support staff. When the polarized-beam transport varies (for example with guide-field direction, or sample
environment condition) there may be several different cellFiles. For each group of datafiles you SOLVE, the correct
cellFile must be selected from the menu. Usually it is possible to tell which data files are to be corrected with which
cellFile from the cellFile-name. If you have problems making this determination consult the He-3 support staff.

At the top of the Edit menu in the group selector there are options for editing and viewing the configura-
tion cellFiles. When pbcor starts, it scans the data directory for all existing configuration files. Choose your
configuration-file from the cellFile menu at the top of the group options section. This configuration file has the
initial polarizations and decay time constants for He3-spin-filters. These are determined during the experiment by
neutron transmission measurements, so that the user should not normally edit these values. The configuration
file also contains one value per cell for the polarized-beam transport efficiency. This number is determined by com-
paring calculated values for the flipping-ratio (based on the He-3 polarization and perfect tranport efficiency) and
the actual measured flipping-ratios from supposedly purely nuclear non-spin flip scattering. If there are anomalies
in the flipping ratio measurements (for example the background contains a spin-flip contribution, or the measur-
ment includes spin-flip cross-section or depolarization) it may be necessary for the user to modify the transport
efficiency.

Use “Open cell editor” from the Edit->He3 cells menu in the group selector to view or modify the He-3 configu-
ration files. The pop-up is shown below. Use the File menu to import or export configuration files or directly edit
the entries. To use a fixed polarizing device such as a supermirror or Heusler crystal, enter the cellName as SM or
Heusler. Normally the configuration files are read from disk whenever a polarized-beam data correction is made.
Use the “lock” check-box if you want to change configuration file parameters and have those changes immediately
available in a correction or simulation. Selecting the “lock” check-box prevents the program from re-reading any
cellfile, and will be cleared if the user changes the group (or unselects “lock”).
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nsl1Files

This menu lists “nsl” files that are found in the working directory. These files are supplied by the He3 support
staff, and are used to handle the angular dependence of opacity for wide-angle He3-spin-filter cells (MACS). These
are automatically applied when a group is solved when the nslFilesEnable check-box is selected at the bottom of
this menu.

mono/filter

This menu in the group options section indicates which monochromator and incident beam filtering are being
used, so that the fraction of half-lambda contamination can be determined and used to correct the raw counts so
that they represent the count-rate from the primary wavelength neutrons only. Normally, MACS uses a cold Be
filter which removes all higher order wavelengths from the neutron beam.

monitor

If counting against the beam-monitor, select whether the monitor is before or after the He3-polarizer (after on BT7
and before for MACS). If you are counting against time use the “none” monitor option. Be aware that using a
beam-monitor placed after a He-3 spin-filter will reduce the monitor count rate by up to an order of magnitude
compared to unpolarized beam, with a corresponding increase in relative statisitical counting uncertainty.

nsfCons and sfCons

Constraints must be placed on unmeasured polarized beam cross-sections. It is useful to choose these at the
beginning of your session, since they will be propagated to any groups that are created later. The standard
constraints are in the last two menus from the analysis-options section (nsfCons and sfCons), although one can
also manually enter constraint coefficients in the table below the menus. You should end up with constraints
enabled (by a checkbox in the enable column) for the missing polarized-beam cross sections in your experiment.

All of the analysis options, including the configuration file can be selected on a per group basis.

CS=0 if no data

Selecting this checkbox in the group options section will automatically constrain a cross-section to zero if there is
no data for the corresponding flipper-state.

Edit Weights

This is a skeleton for future capability and not yet ready for use.
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data tolerances

At the bottom of the group options section the tolerances for independent variables (scan variables) can be set. This
is important as it determines which individual counts get grouped into a polarized-beam data point. The default
tolerances are set by the Set Deflt button and are also set when the first datafiles are read, determining whether
BT7 or MACS is used. The default tolerances are different for BT7 and MACS and often will produce the desired
grouping. Once a group is SOLVED, the grouping of measurments into polarized-beam datapoints can be found
by viewing the ..g#.m file from the fileViewer (check the msrmnts radio-button). An alternative is to select the
“use relaxed tolerances” option. This selection provides tight tolerance for only the common scan variable found
in all the files in the current group, and relaxes all other tolerances. If it is necessary to adjust tolerances for
individual variables, unselect the “use relaxed tolerances” option. Use the menu “data tolerances” to choose the
independent variable and fill in its tolerance value in the entry-box. Tolerances determine when variables are the
“same” for purposes of creating polarized-beam data-points. This is described in more detail in the section making
polarized-beam data groups.

The same set of tolerances are used when creating polarized-beam data groups with the AUTO-GROUP current
group files command found in the group selector Edit->auto-group menu. This is also described in more detail in
the section making polarized-beam data groups.

group selector

The right side of the main application window is the group selector, shown in the following graphic

6



This widget is used to group files into polarized-beam data groups, and contains a set of listboxes to display
the relevant information from files that are read. The current group files and group-number in the “g” column are
highlighted in green. The file-information listboxes display value-ranges where appropriate and can be congruently
sorted by clicking on the column labels. Adjust a listbox column width by right clicking the column label and filling
in the requested width in the pop-up window. This is useful, since the group selector window may be so wide that it
extends beyond the range of your computer screen. When a listbox width is truncated, the view of its contents can
be scanned with mouse-button1. There are also group selector Edit->swap column data menu options to change
the contents of some of the listboxes. These are the “swap ts/date” (swap timestamp with date-time) , “swap E/Ei”,
“swap E/Ef”, “swap H/rotH” and “swap QxQyQzE/Angles” options (H is the current to the horizontal sample guide
field and rotH is the rotation angle for that field).

7



group selector File menu

He3-cells->view/edit cell files

The top section of the group selector File menu has commands related to the configuration files (He3-cellfiles).
If the user adds a cellfile to the working directory after the application has already started, use group selector
File->He3-cells->Rescan for He3-cellFiles to rescan the working directory for cellfiles, and repopulate the cellFile
menu in the group options section. The next two commands allow the user to look at the cells used for the current
group or selected files. The last command in the He3-cells menu just opens the cellfile editor. Once the editor is
opened, the user can import an existing cellFile to view it or edit it, and then export the modified file.

find windows

This provides a pop-up that lists the current toplevel windows. You can raise any of these windows to the top of
the viewing stack, or move the window to the top left corner of the screen. To do either, first select the window with
the mouse left-button. Then click again with left-button to raise, and right-button to move. There are also buttons
to raise and tile the plots. You can also save the selected window in the current graphics format.

save windows

Save the main toplevel windows. Choose the save directory. Choose the graphics file format.

Save session, Quit

User can save their session at any time. The “Quit” command does not save the session. Also closing the main
application window will not save the session. The session information is stored in the working directory in a file
named pbsession. User can delete or rename this file to remove or change the saved session. When the application
is restarted in a directory/folder that has a pbsession file, that session is restored.

group selector Edit menu

The group selector Edit menu can be torn off by clicking on its top perforation. It is shown in the following graphic.
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Open correction simulator

The polarized-beam data correction simulator pop-up is shown in the following graphic.
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The simulator uses the current group cellFile for its configuration, or if the cell editor is being used with “lock”
enabled, the configuration in the editor is used. To use the simulator, the user should use the PrintCells button to
confirm the configuration parameters, and then adjust them if necessary in the “locked” cell editor.
The view shown above is output from the “Examine solved datapts” and “Examine transmission-details” buttons
on the right. This prints information for the active datapt indices entered. Active datapt indices for current group
solution can be found in the datapts listing from the fileViewer (check the datapts radio-button and look at the
leftmost column). Even if you enter an invalid active index, the examination will find the closest active datapts to
the indices you enter. The datapt output first prints the datapt index, chi which is greater thatn zero if the number
of measurements, Na, (PBcounts) is greater than the number of free cross-sections, NSfr. Then information for
each requested datapt and its PBcounts are printed. The first column for datapts is, S, the solved cross-sections
with constrained cross-sections given their fixed values with no errors. The correction errors for the cross-section
results are printed in the columns “Err”, “EP”, and “EC”. The first of these is the total error, while the next two
break out the error components due to parameters and counting statistics respectively. The next four columns
show the inverse of the constrained transmission matrix, Ainv, used to solve for the cross-sections in terms of the
counts listed in the B column. The original transmission matrix and its constrained version are printed in the
next eight columns. The constraint conditions for the datapt are taken from the current group and get printed
out at the far right side of the simulation output. Following the datapt printout is the list of PBcounts for that
datapt. The PBcounts have columns for flipper-state index, fs (1=offoff 3=ONoff), the cell indices, P and A, and the
a4 scattering angle with the 1-Angstrom opacity value for the analyzer cell, nsl1A. The example printout is using a
wide-angle cell on MACS where the opacity from an nsl-file varies with a4. Next are the Counts, monitorCorrect-
edCounts and correctedCountErr columns. R is the effective flipping-ratio at Ei and Ef. The listing concludes with
the time-stamp in seconds and the transmission-matrix and constrained-transmission-matrix coefficients for each
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PBcount. Also shown is the output from the “examine transmission details” button, which has the polarization of
the cells for each count, pol, the cell average pathlength normalized to the straight-through length, plnorm, the
deviation of this average pathlength, plnsig, the transport efficiency, teff, and the transmissions of perferred, t1-H,
and non-preferred, t1+H, spin-states. The Cw are the correction factors that take into account opacity variation in
a Gaussian approximation.

The buttons in the middle part of the Simulation window, allow examination of the matrix inversion process
usually for the solution of a single polarized-beam datapt. Enter some cross-section count-rate values for the un-
constrained flip-states for the group. Enter the initial and final energies for your polarized-beam data-point. Enter
the times in hours (space separated) from cell installation for all of the measurements that you wish to simulate
for this polarized-beam data-point. Then use the CS simulation button to print out the simulation results. If
you are using MACS wide-angle cells you must enter a valid a4 scattering angle that passes through the MACS
analyzer cell. The simulation takes the input cross-section count-rates and applies the transmission and transport
parameters to obtain the expected count rates for all of the entered measurements (and at the requested measure-
ment times). These expected count-rates are printed under the output section “PBcounts” with one line per input
measurement. If the “deviates” check-box is selected, then Poisson counting statistical deviates are added to the
calculated count-rates. Then the simulation corrects the measurements to get back the cross-section count-rates
which are in the rows labelled by the spin-flipper states, offoff, ONON, ONoff and offON in the column labelled “S”.
These corrected cross-section values are printed in the four flip-state lines above the “PBcounts”. If the “deviates”
check-box is not selected, the resulting cross-sections will be exactly the simulation input values. The output
format for the columns is the same as in the “Examine solved datapts” case. The correction errors are printed
in the columns “Err”, “EP”, and “EC”. The first of these is the total error, while the next two break out the error
components due to parameters and counting statistics respectively. You will find that you can reduce the counting
statistics part of the error in the usual way by increasing the total number of counts (making more measurements),
while the part of the error due to polarization-device parameters remains fixed. This error can only be reduced
by reducing the parameter errors found in the cell file. An example using this type of simulation is shown in the
graphic below.

11



Clear the output window with the clear output button, or save your simulation output to the file “pbsim” using
the save output to pbsim button.

The above example simulation has 4 measurements (both offoff and ONoff are measured twice, once at install
time and then ten hours later). Thus least-squares is used to obtain the correction and the resulting Chi value is
printed. At first the solution is obtained without deviates so that Chi=0. Then at the bottom deviates are used. Note
that the column marked Cc was meant for the monitor corrected measured counts, but no monitor corrections are
applied in simulation, so these values are always equal to the C column counts.

Select Y data columns

This pop-up lets the user choose which data columns are to be used in the polarized-beam correction. Note that
the default for ICE files is to choose the single Y column marked “Detector” and for ICP files it is the single Y column
labeled “Counts”.

If you want to change the Y data column selection, first use the fileViewer button and its “select” checkbox
at the very right side to view a selected data file from the current group. This becomes the file that is used to
determine column labels that are put into the left-side listbox in the “Select Y columns” pop-up. Choose Y columns
by selecting entries in the left-side listbox and moving them to the right-side listbox using the arrow buttons
between the two listboxes. You can also use globbing for multiple detectors with similar column names, e.g. SDC?.
Each Y or detector/data-column you choose will contribute to a separate polarized-beam data-point. If you want to
combine detectors before solution, use DAVE or someother utility to create a file with modified detector counts and
errors. Please note that the selection of detectors for solution applies to any files that are read after the selection
is made. All files in a group must use the same detectors selection.

If you choose multiple Y columns for solution, you still will have the option to solve either one or all of these
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detectors by selecting from the group selector solvDet menu.

Select the data columns you want to analyze from the listbox on the left. for multiple columns with similar
names you can use the glob entry (SDC* or SDC?? for example). Move the selection to the right-side listbox with
the arrow-button between the two listboxes. You can remove selected columns using the other arrow-button. Once
satisfied with your selection apply it using the Apply button. This will update the “ny” column for the current group
files in the group selector.

Select X data columns/Use X scan variable

These options choose the single X data column used for plotting group results. If you are not satisfied with the
choice for the X data column made by the program, unselect the “Use X scan variable” from the group selector Edit
menu and and then open the “Select X data column” popup. This works just like the “Select Y data columns” popup
including getting column labels from the current view file.

Subtract background

This command produces a pop-up window that allows subtraction of the fast-neutron/electronic-noise background
from the data. This background is flipper-state independent, so that it must be subtracted before the polarized
beam correction is made. This becomes increasingly important as the magnitude of the background approaches
the magnitude of the real data signal. When this command is selected, a pop-up window becomes available to enter
the background in counts-per-second. The user may also input an error for the background. Multiple subtractions
of background can be made. For example, by subtracting the negative of the previously subtracted background (as
shown in the listbox “fbg”) with the error set at zero, the previous data can be recovered. If non-zero background
errors are used, they will propagate in quadrature with each successive subtraction, so it is best to start over from
the original data.
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Show group info

This command opens a pop-up window that displays per group information collected from the listboxes in the
group selector. This is useful for surveying the groups that have been created. This pop-up has three other im-
portant functions. The first function is to set the “Temp” tolerance using the the temperature tolerance of selected
groups in the group info pop-up, or all of the groups. Read the section on making polarized-beam data groups
to understand why this is important. The buttons set Temp tol from T-range of selGrps or from allGrps actually
set the “Temp” tolerance to 1.1 times the overall range from the selected groups. A second function handled by the
group info pop-up is to view/edit the scale factors for group solutions. In order to directly compare the count rates
for solved groups the scale magnitude and scale type (ref time or monitor) should be the same. The last function
served by the group info pop-up is to set a title for the selected group. This title is displayed at the top of the group
plot. To select a group just click on one of the group numbers in the left side listbox.

Solved group file operations

This command opens a pop-up window that enables averaging or subtracting group results as shown in the fol-
lowing graphic.

To create a new file-operation, from the Edit menu select “New groups subtraction” or “New groups average”.
Then fill in group numbers of the groups (these must be solved groups indicated by green shading in the “g”
column of the group selector ) that you want to subtract from or average in the first entry at the top of the pop-up.
If subtracting you will also be able to enter the group number of the group to be subtracted in the second of the
entries at the top of the pop-up. These group operations of averaging or subtracting are included in this application
because the algorithm may be somewhat more complicated than subtracting ordinary “scan” data-files. The reason
is that it is possible that the polarized-beam data-points are distinguished by multiple independent variables, so
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that using a single “scan” variable would not suffice, although this is the default. Typically, selecting the “common
scan column” for the Edit->Choose independent variables option will work. One can alternatively select “all stnd
ind vars” (the entire list from “data column type” in group options section) or “x-stnd ind vars only” (the Qx Qy Qz)
or “non-x stnd ind vars only” (everything else), or a custom set of up to four data columns using the option “choose
ind vars” and then going to the pop-up displayed by the “config ind var choice”. Finally choose one of the options
for tolerances used in the group result file operation.

To execute the currently highlighted operation in the table, just press the Exec Current Op button. The result-
group listbox entry will get filled in with the group numbers of the result-groups (you only get multiple results when
subtracting from multiple input groups). The result group will have its “g” number highlited in red in the group
selector and will have 5 files that are the same format as files produced when a group is Solved. The first is the
“.p” or polarized-beam data-points file. This file has all four of the Sxy cross-sections listed, while the remaining
files labeled with extensions .A .B .C and .D are the native format files for ICE or ICP with the data for only one
cross-section in each file.

Remove groups

This does just what it says. There is no UNDO. You would have to recreate any deleted groups from scratch.

Remove/Move/Copy files

This does just what it says. There is no UNDO for the Remove operation.

set column width and swap column data

This group of menu commands allows customization of the lengths and widths of the file-information listboxes in
the group selector and also lets the user chose alternate information to display in those listboxes. Listboxes can
be scrolled congruently at any time. The default listbox widths contain the full view of the data and label. To
adjust the individual listbox widths, right-click (Button-2) on the listbox label, and use the fixed-width checkbox
and width-size entry in the pop-up.

The number of types of data that might be displayed is larger than can fit on a typical computer screen, so there
are options to select which data gets displayed in the “swap” commands. Any time that new files are read to the
group selector the listboxes will be returned to there default data contents.

plot editor

The plot editor section is at the bottom of the main application window. It can be used to turn on or off different
components of the group plots. Both solved group plots and plots made for file-operation group (subtract/average
solved groups) contain the solved data elements: uu, du, ud and dd, otherwise labelled offoff, ONoff, offON and
ONON in the legend, where the symbols for each data type are displayed. There are checkboxes in the plot
editor section which control the display of each of these elements. The symbol type for these elements is fixed,
with circles and squares representing the offoff and ONON data, while downward pointing, and upward pointing
triangles represent the ONoff and offON data. The default color for single detector corrected data is blue while
multidetector data is coded by interpolating in a color table (see the edit menu section below). The default is that
all 4 of these elements are displayed using the Y-axis on the left side of the plot.

Solved-group plots also contain elements for the measured data (labelled msr). These use the same symbols
for the flipper-states as the corrected data, but are color coded from red to green according to source data set.
These data use the Y-axis on the right side of the plot. All measurements can be turned on or off using the “msr”
checkbox. The non-spin-flip (nsfmsr) or spin-flip (sfmsr) can similarly be controlled with their checkboxes.

If the “R” checkbox is selected, the solved-group plots will show the flipping ratio values for the measured data,
using the symbol x, and color coded just as the measured data, from red to green. This flipping ratio is the ratio of
expected counts in the non-spin-flip channel, to counts in the spin-flip channel when the cross-section is purely
non-spin-flip. It is a function of both Ei and Ef as well as time if He3 polarizers are used. These flipping ratio data
use the Y-axis on the right side of the plot even if the measured (msr) data are still on.

Individual measured data-sets can be selected for solved-group plots using the msrSet menu.
Select the “pltSelFile” checkbox to enable plotting any file listed in the data selector or group selector. Just

left-click on the file name to get the plot. There is only one plot window for this purpose. Configuration options for
this plot are described in the plot editor->Edit menu section.

plot editor Edit menu

The plot editor->Edit menu is detachable, by clicking on its perforation. In the group solution mode (pltSelFile
unchecked) this menu looks like
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Most of these options are self explanatory. Zooming is accomplished by dragging out the region of interest on
the plot. Return to the unzoomed state by right-clicking on the plot. “other axis scaling” allows auto-scaling or
manual selection of axis limits. At the bottom of the menu are options for saving the current group plot to a file.
This menu is very similar in the “pltSelFile” mode.

making polarized-beam data groups

A polarized-beam data group is a set of files that contain data that can form polararized-beam data points.
Polarized-beam data-points are created from the files in the current group when the Solve button is pressed.
The number of data-points created and solved is displayed in the “npts” entry-box at the top of the group selector.
Recall that the definition of a polarized-beam data point is a set of measured count rates all taken at the same val-
ues of experimental parameters (Q, E, EI , EF , temperature,magnetic−field,etc. but NOT the He3 parameters ), except
that the spin-flipper states can vary. This implies that it is possible to determine when values of the experimental
parameters are the same. This is done before solution, by setting tolerances for the experimental parameters using
the “data column type” menu and the “match tolerance” entry field from the group options section or by selecting
the “use relaxed tolerances” option. For example, if all of the data you plan to put into a data group were taken
at the “same” temperature, make sure the tolerance for the Temp “data column type” is large enough to include all
of your data. You can use the “Show group info” option from the group selector Edit menu, to determine and set
this temperature range. Alternatively, if your group is to contain data taken at “different” temperatures, make sure
the tolerance for Temp is tight enough to distinguish these different temperatures. Another set of experimental-
parameter “data column types” that are important are the sample-guide-field magnitudes and directions specified
as H, V, rotH in the “data column type” menu. These must have the “same” values for a polarized-beam data point.
For example, if rotH, which measures the direction of the horizontal sample guide field, is limited during an exper-
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iment, then the definition of “sameness” may need to be relaxed. Note that H and V, the horizontal and vertical
sample-guide-field currents are shown by default in the group selector file-information listboxes, while rotH is not.
In the group selector Edit->swap column data menu there is an option to “swap H/rotH”. Alternatively, use the
fileViewer button to look at the contents of files and check the values for rotH. Select the “select” checkbox option
in the text file viewer so that any file selected is viewed.

If the files to be used in a polarized-beam data group are known, they can be read directly to a group, and
then processed for correction. Another approach is to read all the relevant files into a group, and then examine
the information in the group selector listboxes to determine which files go into separate groups. There are options
in the group selector Edit menu that allow moving or copying files from one group to another (the current group)
to accomplish this sorting. A third option is to use the AUTO-GROUP current group files command in the group
selector Edit->auto-group menu. This will attempt to create new groups from the files in the current group based
on the “match tolerance” for each “data column type”. Selecting the option “each file can only be in one group” makes
the sorting process somewhat more deterministic. The most restrictive option is to select “files must have all the
same data points”, which means that all the files in a group must be the exact same scan (within the tolerances)
with only the flipper-state changed.

solving polarized-beam data groups

Once files are sorted into groups, adjust the “group” number at the top of the group selector to a group for which
the polarized-beam correction is desired. This becomes the current group, and the filenames for that group will be
hilited in green. Solved groups are indicated by highliting the group number in green. Above the file-information
listboxes, find an Edit menu, that allows editing of group contents, a SOLVE button to execute the solution for the
current group, and buttons and an indicator with up and down arrows to set the current group number. When a
polarized beam group is solved, the number of polarized-beam datapts and measurements are filled into the “npts”
and “nmsr” entries. If the “npts” value is not what you expect it to be, then some tolerances likely need to be
changed. A plot of the solution will also be created. This plot can contain both the corrected data and the original
count rates (corrected for counting against a beam-monitor if necessary). The axis-scale for the corrected data is
on the left-side of the plot, and if the original measurements are shown, that scale is on the right-side of the plot.
When He3-spin-filters are used the corrected data scale will be on the order of 5-30 times larger than the scale for
the original measurements. This is roughly the transmission loss factor due to the He3-spin-filters.

The solution will also create text files that contain the results. The text filenames are derived from the first
filename in the group and have _g# appended to indicate the group number. The polarized-beam corrected data-
points are listed in a file with the additional extension .p. This file lists the results for all 4 polarized-beam
cross-sections using different columns. All of the measurements used in the group solution are in a file with the
additional extension .m. The measurments listed in the .m file are grouped together by data point so that the user
can determine the effect of grouping tolerances. The solved polarized-beam data-points are also listed in native-
format files, with one cross-section per file using the file extensions, .A (offoff), .B (ONoff), .C (offON) and .D (ONON).
Any of these files can be opened in the fileViewer by selecting the file-type check-boxes at the top of the fileViewer
window. All of the input data files are also output with the original data replaced by the polarized-beam corrected
cross-section data in the exact same file format but with file extension .pbcor. Error columns for the correction are
appended to the .pbcor files. The Monitor and Time columns are set to values that match the solution.
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examples of corrected polarized-beam groups

Here is an example of nuclear Bragg peak scans showing how the correction makes the spin-flip channel inde-
pendent of scan variable. In normal samples with background subtracted the spin-flip scattering from a nuclear
Bragg peak would correct to zero. In this example the correction does not make zero because the sample has
hydrogen in it ( a source of incoherent spin-flip background ).
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Here is an example of an energy scan taken with the sample guide field approximately along the scattering
vector, showing the spin-flip and non-spin-flip correction.
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